SPSS Explore procedure

One useful function in SPSS is the Explore procedure, which will produce histograms, boxplots, stem-and-leaf plots and extensive descriptive statistics.  To run the Explore procedure, go to the Analyze menu ( Descriptive Statistics ( Explore…
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Transfer over any dependent measure variables to the Dependent List box by clicking on the variable and the arrow button.  If you want to break results down according to different groups, transfer over the grouping variable to the Factor List box. To specify which plots you produce, click on Plots and select the desired plots.  Click Continue.  You have the option of obtaining statistics only, plots only, or both, so ensure that the correct button is selected in the Display section.  Click on OK when you are ready to proceed.
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You should find that a new window – the SPSS output window – opens with the desired output.  Remember to inspect histograms, boxplots and stem-and-leaf plots for any anomalies.  The table entitled Descriptives provides you with a lot of statistics, so it’s probably not best to copy this into a report – just select what is important.

SPSS Descriptives Procedure

Another useful procedure for obtaining descriptive statistics in SPSS is the Descriptives procedure.  Go to the Analyze menu ( Descriptive Statistics ( Descriptives…
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Transfer over any dependent variables to the Variable(s) box. If you want to change the types of descriptive statistics presented, click on Options and choose the options you want.  Click on Continue.  OK to finish.  The Descriptive Statistics table should appear in the SPSS output window.
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SPSS Means procedure

If you want to produce a table of means for different groups, you can use the Means procedure.  Go to the Analyze menu ( Compare Means ( Means…  
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Transfer over the dependent variable to the Dependent List box, and the grouping variable to the Independent List.  If you want to change what statistics appear in the output, click on Options and transfer over the desired statistics to the Cell Statistics box; click on Continue.  Click on OK to finish.  You now have a nice table of means and standard deviations!
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Producing graphs in SPSS
In SPSS, there are two main ways of producing graphs – the interactive Chart Builder option or the Legacy Dialogs option.  The Chart Builder is more flexible and intuitive, so we will focus on that.  To run the Chart Builder, go to the Graphs menu ( Chart Builder…  
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You may get a message warning you to make sure that the measurement level for each variable is correct.  If you are happy that you selected the correct scale of measurement in the Measure column in the Variable View, then click on OK to proceed.
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In the Chart Builder dialog box, select the desired type of graph from the Choose from list, click on the appropriate picture of a graph and transfer it to the Chart Preview window.  
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You can then click and transfer variables over to the Chart Preview window until you’re happy with what appears in the preview. Note that the preview doesn’t show the graph exactly as it will finally appear, but it gives you the general idea. Clicking on Element Properties will allow you to make changes to the graph (e.g. display median rather than mean). When you’re ready, click on OK.  
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If you want to edit the finished graph in the SPSS output window, double-click anywhere [image: image215.png]One-Way ANOVA: Post Hoc Multiple Comparisons
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 on the graph.  The Chart Editor window will open and you can edit by clicking on elements of the graph (e.g. axes, bars) and using the menus.  The best way to learn how to use this function is to just have a go.
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SPSS procedure for independent samples t-test

Before running an independent samples t-test you should check that your data are in the appropriate format.  As you are comparing different groups, you will need a variable which indicates which group someone belongs to.  Remember to use value labels (e.g. 1 = …, 2 = …).  You will also need a score variable, giving each participant’s individual score.
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You should explore the data thoroughly (e.g. by producing histograms, boxplots etc.) to check that the assumptions of the test have been met. Once you are satisfied that the parametric assumptions have been met, you can run the t-test.  Go to Analyze ( Compare Means ( Independent-Samples T Test…
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In the Independent-Samples T Test dialogue box, transfer the dependent variable (e.g. Scores) to the Test Variable(s) box and the independent variable (e.g. Confederate) to the Grouping Variable box. (You transfer over variables by clicking on the variable and then the arrow button.)

Click on Define Groups… and specify the values used in your Value Labels coding scheme (usually 0 and 1 or 1 and 2). Click on Continue.
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(If you want to change the default confidence interval setting of 95%, you can click on Options… and change the value.)  Click on Continue.  OK to run the t test.

SPSS procedure for paired samples t-test

Before proceeding with the paired samples t-test check that your data are laid out appropriately.  The two sets of scores being compared should be in two separate variables (i.e. each “case” has two scores).  Note that there is no need for a grouping variable here as you are not comparing independent groups. 
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Once you have explored the data and are satisfied that the parametric assumptions have been met, you can run the t- test.  Go to Analyze ( Compare Means ( Paired-Samples T Test…
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In the Paired-Samples T test dialogue box, transfer over your paired variables to the Paired Variables box using the arrow button – one variable to the Variable1 column and the other to Variable2.
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(If you want to change the confidence interval, go to Options…, change the value and click Continue.)  Press OK to run the paired samples t-test.

SPSS Procedure for Mann-Whitney U-test

First of all, check that your data are laid out appropriately.  They should be in the same format as for an independent-samples t test, with a grouping variable and a score variable. 
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There are two different ways of running the Mann-Whitney U-test in newer versions of SPSS (version 18 and on): (1) using the automatic “Independent Samples” procedure, or (2) using the “Legacy Dialogs” procedure. The output produced by both methods is quite different. Note that if you are using an earlier version of SPSS, you can only use the second option here. 

(1)  Running the Mann-Whitney U-test using the automatic “Independent Samples” procedure
To run the “automatic” Mann-Whitney U-test in newer versions of SPSS, go to Analyze ( Nonparametric Tests ( Independent Samples...
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Under Objective, check that your objective is to automatically compare distributions across groups. Notice that in Description at the bottom of the window SPSS tells you that Mann-Whitney U has been selected.
[image: image27.png]Nonparametric Tests: Two or More Independent Samples

Identifies diflerences between two or more groups using nonparametric tests. Nonparametric tests do not assume your data
follow the normal distribution

What is your objective?
Each objective comesponds to a distinct default configuration on the Settings Tab that you can further customize, if desired.

@] Automatically compare distributions across groups!
© Compare medians across groups.

© Customize analysis.

Description
Automatically compare distributions across groups using either the Mann-Whitney U test for 2 samples, or the
Kruskal-Wallis 1-way ANOVA for k samples. The test chosen varies based on your data

(L0 ) (Bese ) (oo (Coret) e |





Click on the Fields tab, and transfer over the variables, with the dependent variable(s) going to the Test Fields box, and the grouping (i.e. independent) variable going to the Groups box. When you are ready you can click on Run to run the test.
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Alternatively, if you don’t like the idea of letting SPSS automatically decide the type of analysis for you, you can always click on the Settings tab, click on Customize tests and select Mann-Whitney U (2 samples) and run the test that way. 
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The output produced by these methods is fairly basic, but it does tell you whether the null hypothesis was supported or not. To get more detail on the test results (e.g. test statistic), double-click on the output; the Model Viewer window will open, which provides a bar chart and further statistics.

(2) Running the Mann-Whitney U-test using the “Legacy Dialogs” procedure

If you are using a version of SPSS earlier than version 18, the “automatic” Mann-Whitney U-test will not be available; you will have to use a different method to run the test. You may also want to use this alternative method if you are using SPSS 18 (or newer version) but have had experience with the earlier method of running the test.
To run the Mann-Whitney U test in SPSS 18 (and newer), go to Analyze ( Nonparametric Tests ( Legacy Dialogs ( 2 Independent Samples…  In earlier versions of SPSS, go to Analyze ( Nonparametric Tests ( 2 Independent Samples…
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In the Two-Independent-Samples Tests dialogue box, transfer over the dependent variable to the Test Variable List box and the independent variable to the Grouping Variable box. Make sure that Mann-Whitney U is selected under Test Type.
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Click on Define Groups and specify the values used in your grouping variable coding scheme. Click on Continue.

By default, SPSS calculates p values for some non-parametric tests using a method that is suitable for larger samples.  However, it is not always accurate for smaller samples or very unusual data distributions.  You are therefore recommended to change this method of calculation to give you the most accurate p value. Click on Exact… and select Exact.  (Don’t worry too much about the time limit per test – if the data set is very large, the exact calculation can take some time, but your data sets are unlikely to be huge.) Click on Continue.  OK to run the test.
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SPSS procedure for Wilcoxon Signed Ranks Test (& Sign Test)
Before proceeding, check that your data are laid out correctly– you should have one row per participant/case and two score variables.  
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There are two different ways of running the Wilcoxon Signed Ranks test  (and the Sign Test) in newer versions of SPSS (version 18 and on): (1) using the automatic “Related Samples” procedure, or (2) using the “Legacy Dialogs” procedure. The output produced by both methods is quite different. Note that if you are using an earlier version of SPSS, you can only use the second option here. 

(1) Running the Wilcoxon Signed Ranks test (& Sign Test) using the automatic “Related Samples” procedure

To run the “automatic” Wilcoxon Signed Ranks test in newer versions of SPSS, go to Analyze ( Nonparametric Tests ( Paired Samples...
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Under Objective, check that your objective is to automatically compare observed data to hypothesized. Notice that in Description at the bottom of the window, SPSS tells you that Wilcoxon Matched-Pair Signed-Ranks is suitable.
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Click on the Fields tab, and transfer over the two score variables that you want to compare. When you are ready you can click on Run to run the test.
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Alternatively, if you don’t like the idea of letting SPSS automatically decide the type of analysis for you, you can always click on the Settings tab, click on Customize tests and select Wilcoxon matched-pair signed-ranks (2 samples) and run the test that way. 
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The output produced by these methods is fairly basic, but it does tell you whether the null hypothesis was supported or not. To get more detail on the test results (e.g. test statistic), double-click on the output; the Model Viewer window will open, which provides a bar chart and further statistics.

To run the Sign Test using this method, follow the same procedure as for the Wilcoxon Signed Ranks Test, but under the Settings tab, select Sign test (2 samples) before running the test.


(2) Running the Wilcoxon Signed Ranks test using the “Legacy Dialogs” procedure

If you are using a version of SPSS earlier than version 18, the “automatic” Wilcoxon signed ranks test procedure will not be available; you will have to use a different method to run the test. You may also want to use this alternative method if you are using SPSS 18 (or newer version) but have had experience with the earlier method of running the test.

To run the Wilcoxon signed ranks test in SPSS 18 (and newer), go to Analyze ( Nonparametric Tests ( Legacy Dialogs ( 2 Related Samples…  (In earlier versions of SPSS, go to Analyze ( Nonparametric Tests ( 2 Related Samples…)
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In the Two-Related-Samples Test dialogue box, transfer over your paired variables to the Test Pairs box and ensure that Wilcoxon is selected under Test Type.
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By default, SPSS calculates p values for some non-parametric tests using a method that is suitable for larger samples.  However, it is not always accurate for smaller samples or very unusual data distributions.  You are therefore recommended to change this method of calculation to give you the most accurate p value. Click on Exact… and select Exact.  (Don’t worry too much about the time limit per test – if the data set is very large, the exact calculation can take some time, but your data sets are unlikely to be huge.) Click on Continue.  OK to run the test.
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Click on Exact… to request that an exact p value is calculated.  Click on Continue. Click on OK to run the analysis.
To run the Sign Test using this method, follow the same procedure as for the Wilcoxon Signed-Ranks test, but deselect Wilcoxon and select Sign under Test Type before running the test.
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SPSS procedure for one-way between-subjects ANOVA

Before any analysis can take place, check that your data are laid out in the appropriate format.  In order to run a one-way between-subjects ANOVA in SPSS you need a grouping variable (remember to use value labels, e.g. 1 = control, 2 = imagery and so on) and a variable for each participant’s score. (Remember that you can switch between whether you see the values or the value labels by clicking on the [image: image46.png]Fle ER Vew Dala ITransform Amalyze Graphs Uiities Addons  Window Hel
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 button in the toolbar or by going to the View menu and selecting Value Labels.)
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Next, you should explore your data to determine whether the parametric assumptions of the test have been met. If they have been satisfied, you can proceed with the ANOVA.
There are two different ways to run a one-way between-subjects ANOVA in SPSS: (1) using the One-way ANOVA procedure, which is a simple method and produces simpler output, or (2) using the Univariate procedure, which can be slightly more complicated to run, but provides more control and more detailed output (including effect sizes).
(1) Running the one-way between-subjects ANOVA using the One-way ANOVA procedure
To run the one-way between-subjects ANOVA, go to the Analyze menu ( Compare means ( One-Way ANOVA…  
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Transfer over the score variable to the Dependent List box, and the grouping variable to the Factor box.
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To make post hoc comparisons, click on Post Hoc…, select the test of choice and click Continue.  For a one-way between-subjects ANOVA, you are recommended to use Tukey’s HSD test, so select Tukey.

[image: image52.png]Dependent List

& case rumber (Case]

£

2

& Number of words corr

Factor:

& nstruction conton [Co.

(Lo (eese ) (mset ) (comal) e J






Clicking on Options… allows you to select Descriptive (for a table of descriptive statistics) and Homogeneity of variance test (to check if this assumption has been met).  Click on Continue.
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When you are ready to run the ANOVA, click on OK.
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(2) Running the one-way between-subjects ANOVA using the Univariate procedure

To run this method, go to Analyze ( General Linear Model ( Univariate…  
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Transfer over the score variable to the Dependent Variable box and the grouping variable to the Fixed Factor(s) box.
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A line graph of the group means is often quite helpful when trying to interpret an ANOVA result.  To obtain one, click on Plots…, transfer over the grouping variable to the Horizontal Axis box, click Add and Continue. (You must remember to click on Add, or the plot won’t appear in your output.)
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To request post hoc tests, click on Post Hoc…, transfer over the grouping variable to the Post Hoc Tests For box and select the test of choice.  You are recommended to use Tukey’s HSD test here, so select Tukey.  Click on Continue.
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Clicking on the Options… button allows you to make some additional requests such as descriptive statistics, estimates of effect size and tests of homogeneity of variance. Click on Continue when you have finished with the options.
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When you are ready to proceed with the ANOVA, click on the OK button.
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SPSS procedure for one-way within-subjects ANOVA

To begin with, ensure that your data are in the correct format, with one variable per condition.  For example, if an experiment had four conditions (within-subjects), each participant will need a separate variable for each of their four scores.  Note that there is no need for a grouping variable and value labels as there are no separate groups.
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You should then explore your data and check that the assumptions of the test are met.
To run the one-way within-subjects ANOVA, go to Analyze ( General Linear Model ( Repeated Measures…
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In the Repeated Measures Define Factor(s) window you need to tell SPSS what your within-subjects factor (i.e. independent variable) was and how many levels (i.e. conditions) it had. Change “factor1” in the Within-Subject Factor Name box to something meaningful (e.g. Memory_Condition) and type in the number of levels.  Click Add.  You can also enter the dependent variable in the Measure Name box (e.g. Number_of_words), to remind you what the numbers in the score columns represent, if you want (it’s not essential).  Click Add and then Define.
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You should now transfer over your score variables for each of the conditions to the Within-Subjects Variables box.
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To obtain post hoc tests for the one-way within-subjects ANOVA you don’t click on Post Hoc… (this is only used for more complex mixed designs), but click on Options… instead.  Transfer over the factor name to Display Means for, click on Compare main effects and select a post hoc test from the drop-down menu.  You are recommended to use Bonferroni as it makes adjustments for the number of comparisons made. You should also select Descriptive statistics and Estimates of effect size. Click on Continue.










If you would like a line graph of the means, click on Plots… , transfer over the factor name to Horizontal Axis, click on Add and Continue.


             

         






When you are ready to run the analysis, click on OK.



SPSS procedure for Kruskal-Wallis test

To run the Kruskal-Wallis test, first check that your data are laid out correctly, with a grouping variable and a score variable.  
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There are two different ways of running the Kruskal-Wallis test in newer versions of SPSS (version 18 and on): (1) using the automatic “Independent Samples” procedure, or (2) using the “Legacy Dialogs” procedure. The output produced by both methods is quite different. Note that if you are using an earlier version of SPSS, you can only use the second option here. 

(1) Running the Kruskal-Wallis test using the automatic “Independent Samples” procedure
To run the “automatic” Kruskal-Wallis test in newer versions of SPSS, go to Analyze ( Nonparametric Tests ( Independent Samples...
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Under Objective, check that your objective is to automatically compare distributions across groups. Notice that in Description at the bottom of the window SPSS tells you that Kruskal-Wallis has been selected.
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Click on the Fields tab, and transfer over the variables, with the dependent variable(s) going to the Test Fields box, and the grouping (i.e. independent) variable going to the Groups box (SPSS will automatically choose Kruskal-Wallis if the grouping variable has three or more groups). When you are ready you can click on Run to run the test.
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Alternatively, if you don’t like the idea of letting SPSS automatically decide the type of analysis for you, you can always click on the Settings tab, click on Customize tests and select Kruskal-Wallis 1-way ANOVA (k samples). If you would like post hoc multiple comparisons, you can select this from the drop-down. Don’t forget to click on Run.
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(2) Running the Kruskal-Wallis test using the “Legacy Dialogs” procedure

If you are using a version of SPSS earlier than version 18, the “automatic” Kruskal-Wallis test will not be available; you will have to use a different method to run the test. You may also want to use this alternative method if you are using SPSS 18 (or newer version) but have had experience with the earlier method of running the test.

To run the Kruskal-Wallis test in SPSS 18 (and newer), go to Analyze ( Nonparametric Tests ( Legacy Dialogs ( K Independent Samples…  (In earlier versions of SPSS, go to Analyze ( Nonparametric Tests ( K Independent Samples…)
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Check that Kruskal-Wallis H is selected under Test Type. You should transfer over your score variable to the Test Variable List box, and the grouping variable to the Grouping Variable box.  Click on Define Range and enter the lowest and highest of the numbers in your Value Labels coding scheme, and then click Continue.
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You are also recommended to click on Exact….  Select Exact and click on Continue.
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When you are ready to run the analysis, click on OK. 
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SPSS procedure for Friedman test
To run the Friedman test, first check that your data are laid out correctly, with a separate score variable for each condition.  
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There are two different ways of running the Friedman test in newer versions of SPSS (version 18 and on): (1) using the automatic “Related Samples” procedure, or (2) using the “Legacy Dialogs” procedure. The output produced by both methods is quite different. Note that if you are using an earlier version of SPSS, you can only use the second option here. 
(1) Running the Friedman test using the automatic “Related Samples” procedure
To run the “automatic” Friedman test in newer versions of SPSS, go to Analyze ( Nonparametric Tests ( Related Samples...
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Under Objective, check that your objective is to automatically compare observed data to hypothesized. Notice that in Description at the bottom of the window, SPSS tells you that Friedman’s 2-Way ANOVA by Ranks is suitable. (Don’t worry about the “2-way” bit here – it’s the same Friedman test that is used to look at one within-subjects variable.) 
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Click on the Fields tab, and transfer over the score variables that you want to compare (i.e. the levels of your factor). When you are ready you can click on Run to run the test.
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Alternatively, if you don’t like the idea of letting SPSS automatically decide the type of analysis for you, you can always click on the Settings tab, click on Customize tests and select Friedman’s 2-way ANOVA by ranks (k samples). If you would like post hoc multiple comparisons, you can select this from the drop-down. Don’t forget to click on Run.
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(2) Running the Friedman test using the “Legacy Dialogs” procedure

If you are using a version of SPSS earlier than version 18, the “automatic” Friedman test will not be available; you will have to use a different method to run the test. You may also want to use this alternative method if you are using SPSS 18 (or newer version) but have had experience with the earlier method of running the test.

To run the Friedman test in SPSS 18 (and newer), go to Analyze ( Nonparametric Tests ( K Related Samples… 
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Check that Friedman is selected under Test Type.  Then transfer over all of the score variables to the Test Variable box.  Click on Exact… and select Exact to obtain precise probabilities.  Click on Continue and then OK when you are ready to proceed with the analysis.
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SPSS procedure for between-subjects factorial ANOVA.

The SPSS procedure for a between-subjects factorial ANOVA is very similar to that of a one-way between-subjects ANOVA using the General Linear Model procedure. 

First of all, you should ensure that your data are laid out correctly. For a between-subjects factorial design you should have a separate grouping variable for each between-subjects factor (i.e. two-factor design ( two grouping variables, three-factor design ( three grouping variables).  Don’t forget to include your score variable either.
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As usual, the next stage is some exploratory data analysis to obtain descriptive statistics and inspect data distributions.  Once you are satisfied that the assumptions of the test have been met, you can run the ANOVA.  Go to Analyze ( General Linear Model ( Univariate… 
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Transfer over the dependent variable to the Dependent Variable box, and all of the between-subjects factors to the Fixed Factor(s) box.
[image: image89.png]i Univariate

Dependent Variabie:

& Perscnaiytye erso
e —
& Lite Safistaction score.

Fixed Factor(s):

Random Factor(s)

Covarite(s):

WS Weight:

o () ) )





[image: image90.png]Dependent Variabie:

Case number [Case]

»

& Lite Stistacton score [

Fixed Factor(s):

& Perscnaiy tye erso

Random Factor(s)

Covarite(s):

WS Weight:

(Lo (eese ) (st ) (comcl) e )





Click on Plots… to obtain a line graph of the means to help you interpret any interactions.  Transfer over one of the factors to the Horizontal Axis box and one to Separate Lines – it doesn’t really matter which way round you put then, but it’s usually easier to interpret if you put the factor with the most levels on the horizontal axis.  If you are analysing data from a three-way between-subjects factorial design, you should put the third factor in the Separate Plots box. You can also request plots showing just one factor (to help you interpret main effects) by transferring over the factor name to Horizontal Axis. Remember to click Add and Continue.





For a 2 x 2 design, there is no need for post hoc tests as a significant main effect merely requires looking at the table of means to determine which of the two conditions has the highest mean.  In fact, SPSS won’t run post hoc tests for factors with two levels even if you tell it to!  However, if one factor has three or more levels, you should request post hoc tests by clicking on Post Hoc…  Transfer over the variable(s) of interest (i.e. between-subjects factors with three or more levels) to the Post Hoc Tests For box, select the desired post hoc test (e.g. Tukey) and click Continue.  (Our example has a 2 x 2 design, so there is actually no need to request post hoc tests here, but we’ve shown you how SPSS would look if you transferred over the factors.)





Before running the analysis, click on Options… Transfer over the names of the factors and interaction to the Display Means For box.  This will produce tables of means to help you with interpreting your ANOVA results.  (Transferring over OVERALL will give you a table with the grand mean, which you won’t need when interpreting results.)  Although you should already have calculated descriptive statistics, these tables are helpful since they break down the results and make it clear what means you are comparing.  In Options you should also select Descriptive Statistics (if you want yet another table of descriptives!), Estimates of effect size and Homogeneity tests.  Click on Continue. 









When you have finished, click on OK.
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SPSS procedure for within-subjects factorial ANOVA

The SPSS procedure for a within-subjects factorial ANOVA is very similar to that for one-way within-subjects ANOVA.  The main difference is that you need to specify more than one within-subjects factor.

As always, first check that your data are laid out correctly.  You should have a separate variable for every condition (i.e. for every possible combination of the levels of the factors).  There is no need for a grouping variable as the design is entirely within-subjects.  In our example in chapter 18 we had one factor with three levels and one factor with two levels, giving us six conditions and six variables in SPSS.  Note that we have used variable names such as “quiet12” and “noisy24”, to give an indication of the levels of each factor in each condition.  We would strongly advise that you use a similar format – as you will see later, it’s very important that you know which variable represents which condition.
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Next, conduct exploratory analysis to “get a feel” for the data, to check for any errors in data entry and to confirm that the data are suitable for ANOVA.  Once you are satisfied that the test assumptions have been met go to Analyze ( General Linear Model ( Repeated Measures…
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We now need to specify our within-subjects factors.  Type the name of the first factor in Within-Subject Factor Name (e.g. time) and enter the number of levels for that factor (e.g. 3), and press Add.  Repeat for the other within-subject factor(s) (e.g. noise, 2).  Note that number of levels refers to the number of levels for a specific factor and not to the total number of conditions – students often make this mistake and say, for example, that there is one factor with six levels rather than one factor with three levels and another with two.  If you want to, you can enter the name of the dependent variable in the Measure Name box.  When you are ready to proceed, click on Define.
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You now have to tell SPSS which variable represents which condition.  In the Within-Subjects Variables box each condition is specified by two numbers – the first represents the level of factor 1for that condition and the second represents the level of factor 2.  The order in which you entered your factors previously will determine which is factor 1 and factor 2.  SPSS also tells you the order of the factors in parenthesis after the Within-Subjects Variables heading.  Here, time was entered as the first factor and noise as the second.  Thus, a condition labelled as 1, 2 means that it is the condition containing the first level of the time factor (i.e. 12 seconds) and the second level of the noise factor (i.e. noisy); a condition labelled as 2, 1 contains the second level of time (i.e. 24 seconds) and the first level of noise (i.e. quiet); and so on.  

You should transfer over each of the score variables to the Within-Subjects Variables box, ensuring that you have matched correctly the variables and conditions.  Don’t just assume that the way that the variables appear in the box on the left-hand side is the way that they should be transferred over.  This is a very common error, so please be careful when doing this part of the procedure.
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Next, click on Plots… and transfer one of the variables to Horizontal Axis and one to Separate Lines.  If you had a three-way design, you would put the third factor in Separate Plots. You can also request plots with just one factor, to help you interpret main effects. Click on Add and Continue.
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Next, click on Options…  Transfer over the factor names and interaction to Display Means For.  Click on Compare main effects and select Bonferroni from the drop-down list.  (Remember that this is the only way to obtain post hoc tests for within-subjects factors.)  You should also select Descriptive Statistics and Estimates of effect size.  Click on Continue.



[image: image98.png]epeated Measures

& case rumber (Case]

»

Wi Subjects Variables
(ime poise)

Between-Subjects Factor(s)

Covarites:

(Lo (eese ) (st ) (comal) e )







Click on OK to run the test.
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SPSS procedure for mixed factorial ANOVA

The procedure for a mixed factorial ANOVA is very similar to that for within-subjects ANOVA, except with the addition of transferring over a grouping variable.  But first, you need to check that your data are laid out correctly.  There should be a grouping variable for the between-subjects factor, and separate variables for each of the levels of the within-subjects factor.
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After you have explored the data thoroughly and are confident that the data are ready for analysis, you can begin.  Go to Analyze ( General Linear Model ( Repeated Measures…
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As we have a within-subjects factor, we need to define it using the same process as for a within-subjects ANOVA.  Enter the within-subjects factor name in the appropriate box and then the number of levels (i.e. frequency, 3); click Add.  If you want to remind yourself of the dependent variable, enter its name in the Measure Name box.  Click Define.
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Again, as with a within-subjects ANOVA, we have to tell SPSS which score variables correspond to which conditions.  Transfer over the score variables to the Within-Subjects Variables box.  The grouping variable should be transferred to the Between-Subjects Factor(s) box.
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Click on Plots… and transfer over a variable to Horizontal Axis (it makes more sense for this to be the within-subjects factor) and the other variable to Separate Lines.  Click on Add. Remember you can request plots of individual factors if you want. Click on Continue.
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In our example, there is no need for us to click on Post Hoc… as our between-subjects factor only has two levels.  However, if your between-subjects factor has three or more levels, you should click on Post Hoc…, transfer over the factor to Post Hoc Tests For and select the test of choice (e.g. Tukey).  Click on Continue.
[image: image106.png]Repeated Measures

& case rumber (Case]

»

Wi Subjects Variables
(requency)

(One_time(t Juged_freq)
Two_tines(2,Judged_trea)
Three_fimes(3,udged._freq)

Between-Subjects Factor(s)

Covarites:

(Lo (eese ) (st ) (comal) e )






Next, click on Options…  Transfer over the factor names and interaction to Display Means for, click on Compare main effects and select Bonferroni from the drop-down menu.  You should also select Descriptive Statistics, Estimates of effect size and Homogeneity tests.  Click on Continue.
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Click on OK to run the test.
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SPSS Procedure for Pearson Correlation

As always, before conducting any analysis in SPSS, you should ensure that the data are entered correctly and that they have been explored.  For a correlation, you will need variables containing the scores of the variables that are to be correlated.  
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It’s a good idea to check a scatterplot before running the correlation, to see if there is evidence of a non-linear relationship (in which case, a non-parametric correlation should be used, provided the relationship is also monotonic – in one direction).
To run the Pearson correlation in SPSS, go to Analyze ( Correlate ( Bivariate… 
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Simply transfer over the variables to be correlated to the Variables box (you can transfer over more than two variables if you want to look at several correlations at once).  If you haven’t already obtained descriptive statistics, you can request them by clicking on Options…(  select Means and standard deviations ( Continue.  Ensure that is selected under Correlation Coefficients and that Flag significant correlations is selected (this will mean that any significant correlations will be highlighted with an asterisk *).  Press OK to run the correlation.
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SPSS procedure for Spearman’s correlation and Kendall’s tau

Running non-parametric correlations in SPSS is very similar to running Pearson’s correlation, the only difference being that you deselect Pearson as your correlation of choice and select another.
To run a non-parametric correlation in SPSS, go to Analyze ( Correlate ( Bivariate… 
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Transfer over the variables to be correlated to the Variables box. If you haven’t already obtained descriptive statistics, you can request them by clicking on Options…(  select Means and standard deviations ( Continue.  Select your chosen correlation coefficient under Correlation Coefficients and check that Flag significant correlations is selected.  Press OK to run the correlation.








SPSS Procedure for Partial Correlation

To run a partial correlation, you will need several score variables: the variables that you are interested in correlating, plus the variable that is being controlled for.
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To run a partial correlation in SPSS go to Analyze ( Correlate ( Partial…
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Transfer over the variables of interest to the Variables box, and transfer the variable that you want to control for to the Controlling For box.  Click on Options… and select Zero-order correlations; this will give you the original correlations without any variables being controlled for.  Click on Continue and OK.
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SPSS procedure for simple linear regression

In SPSS Data View, data for regression should be laid out and explored in a similar way to correlations.  
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You are strongly advised to produce a scatterplot to explore the data (see Producing graphs in SPSS). To obtain the best-fitting line in an SPSS scatterplot, double-click on the scatterplot in the Output windown; the Chart Editor window should open up. Click on the [image: image119.png]in Chart Editor
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 icon, or go to Elements ( Fit Line at Total, ensuring that Linear has been selected.  
Having explored the data, you can move on to the regression analysis.  Go to Analyze ( Regression ( Linear…  In the Linear Regression box, transfer over the variable you want to predict to the Dependent box and your predictor variable to the Independent(s) box.
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Click on Statistics… and select Descriptives and Casewise Diagnostics.  (Estimates and Model Fit should already be selected by default.)  Descriptives produces a table of means and standard deviations, and Casewise Diagnostics can help to identify any outliers.  Click on Continue.
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Click on Plots… and transfer *ZRESID to the Y box and *ZPRED to the X box.  *ZPRED is the scores predicted by the regression equation, but in a standardised format – z-scores.  *ZRESID is the standardised residuals (i.e. the differences between actual y scores in the data set and predicted scores based on the regression equation, expressed as z-scores). The resulting plot will allow you to check for heteroscedasticity. You can also select Histogram and Normal probability plot under Standardized Residual Plots to help you check the residuals.  Click on Continue.
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When you are ready to proceed, click on OK.
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SPSS Procedure for Multiple Regression

Before you proceed with any multiple regression, you should always check that your data are laid out correctly – you should have multiple score variables (you can also use dichotomous variables in multiple regression).
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You should explore your data carefully as multiple regression makes a number of assumptions about the data. For example, you should look at correlations between your variables to check for multicollinearity (i.e. high correlations between predictor variables).

To run the multiple regression analysis go to Analyze ( Regression ( Linear…  
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Transfer over the criterion variable (the variable you want to predict) to the Dependent box, and the predictor variables to the Independent(s) box.
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Next, select your preferred method of regression from the drop-down menu. Select Enter if you want to run a simultaneous multiple regression, or one of the other options if you want to use a form of stepwise multiple regression. (If you want to run a hierarchical regression, this is a little bit more complicated – see below.)
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Next, click on Statistics and select the same options as for the simple linear regression (i.e. Estimates, Model fit, Descriptives and Casewise diagnostics); click on Continue.
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You also need to produce a plot of *ZPRED x *ZRESID.  Click on Plots… and transfer *ZRESID to the Y box and *ZPRED to the X box, and select Histogram and Normal probability plot if desired.  Continue.
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When you are ready, click on OK.
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SPSS Procedure for Hierarchical Regression

To run a hierarchical multiple regression, you specify the order in which the predictor variables are entered into the model.  Follow the same procedure as before, but when transferring over predictor variables, do it in stages, in the order you want the variables to be entered into the model. Transfer over the first predictor variable(s) to the Independent(s) box and click on Next, and transfer over the predictor(s) you want entered into the next stage of the regression and so on.  You should ensure that Enter is selected as the method of regression.  All other options are the same as for the other multiple regressions, although it is quite helpful to also have R Squared Change selected under Statistics.
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SPSS Procedure for Chi-square test of goodness-of-fit

To run the chi-square test of goodness-of-fit in SPSS, you should first ensure that you have set up your variable of interest as a nominal variable, with appropriate value labels (e.g. 1 = car, 2 = bus, etc.).  You can enter your data in two ways if you are dealing with nominal data.  The first option is what you will be most familiar with: one row per participant.  Thus, for each participant, you would enter the appropriate category and would have as many rows of data as you have participants.  Remember to select Value Labels under the View menu to see the labels instead of values.
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The second option can be used if you are dealing only with nominal data.  You create a nominal variable as usual, but also create a frequency or count variable which will contain the number of cases belonging to each category.   This means that each row will not represent a different participant, but instead a different category.  
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If you use this method, you must tell SPSS that the numbers in the frequency variable are not scores for individual participants, but overall counts.  To do this, go to the Data menu ( Weight Cases…, and transfer across the variable that contains the frequencies or counts to the Frequency Variable box.  Click on OK.
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This method of entering nominal data can be very convenient, but a word of warning: it is very easy to forget to weight cases and you end up with very strange results.  You also have to count up the frequencies yourself before entering any data, and the method isn’t suitable when you have other non-nominal variables. For these reasons, it’s probably safest to stick to the one row equals one participant method of entering frequency data.  
Once the data have been entered, you can run the analysis.  There are two different ways of running the chi-square test of goodness-of-fit in newer versions of SPSS (version 18 and on): (1) using the automatic “One Sample” procedure, or (2) using the “Legacy Dialogs” procedure. The output produced by both methods is quite different. Note that if you are using an earlier version of SPSS, you can only use the second option here. 

(1) Running the chi-square test of goodness-of-fit using the automatic “One Sample” procedure
To run the “automatic” chi-square test of goodness-of-fit in newer versions of SPSS, go to Analyze ( Nonparametric Tests ( One Sample...
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Under Objective, check that your objective is to automatically compare observed data to hypothesized (it should be the default). Notice that in Description at the bottom of the window SPSS tells you that chi-square is suitable.
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Click on the Fields tab, and transfer over the nominal variable to the Test Fields box. (If the case number variable is already there, transfer it back to the Fields box.) When you are ready you can click on Run to run the test.
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If your predicted frequencies are not equal (e.g. if based on a comparison population), you should not run the chi-square test in this way as it assumes equal predicted proportions. Instead, you should customise the analysis. Click on the Settings tab, click on Customize tests and select Compare observed probabilities to hypothesized (Chi-Square test). 
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If you want to specify the predicted frequencies, click on Options, then Customize expected probability and enter the value for each category and its expected frequency
 (this can be an actual count or a percentage, as long as all the expected frequencies are expressed on the same scale). Click on OK. Don’t forget to click on Run once you’re done.
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(2) Running the chi-square test of goodness-of-fit using the “Legacy Dialogs” procedure
If you are using a version of SPSS earlier than version 18, the “automatic” chi-square test will not be available; you will have to use a different method to run the test. You may also want to use this alternative method if you are using SPSS 18 (or newer version) but have had experience with the earlier method of running the test.

To run the chi-square test of goodness-of-fit in SPSS 18 (and newer), go to Analyze ( Nonparametric Tests ( Legacy Dialogs ( Chi-Square…  (In earlier versions of SPSS, go to Analyze ( Nonparametric Tests ( Chi-Square…)
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 Transfer across the nominal variable to the Test Variable List box.  Next, click on Exact… and select Exact to obtain precise p values, and then Continue.
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The Expected Values section is where you effectively tell SPSS what your null hypothesis is.  If your null hypothesis states no preference, then just leave the default selection, All categories equal.  However, if your null hypothesis states no difference from a comparison population, you should click on Values and then enter, one at a time, the expected frequencies or percentages for each category.  You should do this in the order that the categories were defined originally, and make sure you click on Add each time. Once you’re done, click OK.
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SPSS Procedure for Binomial Test
Like the chi-square test of goodness-of-fit, there are two different ways of running the binomial test in newer versions of SPSS (version 18 and on): (1) using the automatic “One Sample” procedure, or (2) using the “Legacy Dialogs” procedure. The output produced by both methods is quite different. Note that if you are using an earlier version of SPSS, you can only use the second option here. 
(1) Running the binomial test using the automatic “One Sample” procedure
To run the binomial test, you can just follow the same procedure as for the “automatic” chi-square – SPSS will recognise that the nominal variable has only two categories and so will run the binomial test accordingly. Go to Analyze ( Nonparametric Tests ( One Sample...
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Under Objective, check that your objective is to automatically compare observed data to hypothesized (it should be the default). Notice that in Description at the bottom of the window SPSS tells you that the binomial test is suitable.
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Click on the Fields tab, and transfer over the nominal variable to the Test Fields box. (If the case number variable is already there, transfer it back to the Fields box.) When you are ready you can click on Run to run the test. SPSS will automatically recognise the fact that there are only two categories in your nominal variable and will select the binomial test.
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If your hypothesised proportions are not equal (e.g. if based on a comparison population), you should not run the binomial test in this way as it assumes equal hypothesised proportions. Instead, you should customise the analysis. Click on the Settings tab, click on Customize tests and select Compare observed binary probability to hypothesized (Binomial test). 
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If you want to specify the predicted proportions, click on Options, then change the value showing in Hypothesized proportion. This should be the proportion corresponding to the first category (i.e. whichever category has the lowest value).  Click on OK. Don’t forget to click on Run once you’re done.
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(2) Running the binomial test using the “Legacy Dialogs” procedure
If you are using a version of SPSS earlier than version 18, the “automatic” binomial test will not be available; you will have to use a different method to run the test. You may also want to use this alternative method if you are using SPSS 18 (or newer version) but have had experience with the earlier method of running the test.

To run the binomial test in SPSS 18 (and newer), go to Analyze ( Nonparametric Tests ( Legacy Dialogs ( Binomial…  (In earlier versions of SPSS, go to Analyze ( Nonparametric Tests ( Binomial …)
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Transfer across the nominal variable to the Test Variable List box.  To obtain precise p values, click on Exact..., select Exact and OK.  The Test Proportion box shows you the proportion stated in the null hypothesis.  If the proportion corresponding to the first category in the test variables for your particular null hypothesis is not .50 (50%), then change it accordingly.  In the current example, however, our null hypothesis would assume 50%.  When you are ready to proceed, click on OK.
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SPSS procedure for chi-square test of association

Before running the chi-square test of association, you should ensure that you have two nominal variables.  For our example in chapter 20, you would therefore need a gender variable and a smoking variable. Remember that you can enter nominal data in two different ways (see SPSS Procedure for Chi-square test of goodness-of-fit for further details), so you may also need a frequency variable if you intend to weight cases. 
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To run the chi-square test of association, go to Analyze ( Descriptives ( Crosstabs… (Note that the chi-square procedure under the Nonparametric Tests menu is NOT suitable for this type of chi-square – you would end up with two separate chi-square tests of goodness-of-fit.) 
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Transfer one of the nominal variables to the Row(s) box and the other nominal variable to the Column(s) box. It doesn’t really matter which way round you put them – it’s all a matter of what you think will look best in the contingency table that will be produced.
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Next, click on Exact…, select Exact and Continue, to obtain precise p values.  
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Then click on Statistics…  It’s important that you don’t miss out this bit or you won’t have a chi-square.  Select Chi-square and Phi and Cramer’s V (effect sizes).  Click on Continue.
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Now click on Cells…  This is where you can specify what information you want included in your contingency table.  Observed Counts is selected by default, but you are also recommended to select Expected Counts.   It’s sometimes useful to include percentages in your contingency table, to aid with comparison, so select Row, Column and Total Percentages if you want them.  You may also want to select Unstandardized Residuals, which will tell you the difference between the observed and expected counts.  Click on Continue when you are ready.
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The last thing for you to do is to select Display clustered bar charts if you would like a bar chart of your data.  This can be helpful in identifying associations.  Finally, click on OK.
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Enter name of dependent variable











Transfer over score variables, taking care to match them with the appropriate condition











Transfer over one factor to here











Transfer over the other factor to here











Transfer over factors and interaction





Select “Bonferroni” from drop-down menu








Score variables (i.e. levels of within-subjects factor)








Grouping variable (i.e. between-subjects factor)








Enter number of levels








Type in within-subjects factor name








Type in name of dependent measure








Transfer over between-subjects factor (i.e. grouping variable)








Transfer over score variables








Transfer over the other factor to here











Transfer over one factor to here











Transfer over between-subjects factors with three or more levels





Select “Bonferroni” from drop-down menu








Transfer over factors and interaction





Score variables





Transfer over variables to be correlated








Transfer over variables to be correlated








Select correlation coefficient








Variable being controlled for








Transfer over variable(s) to be controlled for








Transfer over variables to be correlated








Score variables








Transfer over predictor variable








Transfer over variable to be predicted








Transfer *ZRESID (standardised residuals) to here








Transfer *ZPRED (standardised predicted scores) to here








Select additional plots if desired








Multiple score variables








Transfer over the criterion variable (i.e. the variable you want to predict)








Transfer over the predictor variables (i.e. the variable you want to predict)








Transfer *ZPRED (standardised predicted scores) to here








Select regression method








Transfer *ZRESID (standardised residuals) to here








Transfer *ZPRED (standardised predicted scores) to here








Select additional plots if desired








Transfer over variable(s) to be entered in the first stage of the regression








Transfer over criterion variable (i.e. variable to be predicted)








Transfer over variable(s) to be entered in the next stage of the regression








One nominal (categorical) variable








Frequency (or count) variable








Nominal (categorical) variable








Transfer over nominal variable (NOT frequency variable)








SPSS tells you about the test here





Select the most appropriate objective





Transfer over nominal variable





Enter expected frequency/proportion





Enter value used in value labels





Enter predicted values in order





Select if your null hypothesis is not equal proportions





Select if your null hypothesis is equal proportions





SPSS tells you about the test here





Select the most appropriate objective





Transfer over nominal variable





Change proportion for first category





Adjust test proportion if hypothesised proportions not .50





Transfer over dichotomous variable





Frequency (or count) variable. Remember to weight cases! 





Two nominal variables





Two nominal variables





Transfer over other nominal variable to here 





Transfer over one nominal variable to here 





Select to get residuals (difference between observed and expected frequencies)





Select to get percentages (if desired) 








� If your predicted frequency ends in a zero (e.g. 20, 100), you may find that SPSS drops the zero (it does on my computer!). To avoid this, enter the predicted frequency with a decimal point (e.g. 20.0, 100.0).





